
 
PS3 GAMESHARK HD MOVIE PLAYER AND MEDIA MANAGER MANUAL 

 
 
Please note- Always check www.gameshark.com for the latest version of this manual, and other guides, hints 
and tips on how to use your software. 
 
1) GETTING STARTED  
a) Minimum System Requirements 
To use PS3 GameShark Movie Player and Media Manager you must have a PC running Windows 2000, or XP. 
It is advisable to have over 500MB of disk space free for storing the various file types that are available via PS3 
GameShark Movie Player and Media Manager. You will need a CD-ROM drive and one free USB port. 
 
A PC modem and an account with an Internet Service Provider (ISP) or a dial-up Internet connection is 
required to use PS3 GameShark Movie Player and Media Manager. 
 
The PS3 GameShark HD Movie Player and Media Manager software works by connecting to a Memory Stick 
(MS), SD card (SD), Compact flash card (CF), USB Memory device such as a HDD or by connecting to PSP 
console (with Memory Stick inserted). The files are converted and copied to these memory cards/devices, and 
they can then be inserted into the PS3 console either directly or via card reader. 
 
b) Setting up PS3 GameShark Movie Player and Media Manager for the first time 

1. Insert the PS3 GameShark Movie Player and Media Manager disc into the CD-ROM drive of your PC 
and close the drawer. 

2. After a few seconds, the installation launch panel will appear. If the launch panel does not 
automatically appear, double-click on the My Computer Icon, and then double-click on the CD-ROM 
icon. Now double-click on the PS3GameShark.exe file to bring up the launch panel. 

3. Follow the on-screen prompts to install PS3 GameShark Movie Player and Media Manager onto your 
PC. 

 
c) Connecting to your MS, SD, CF, USB Memory or PSP. 

1. Insert your MS, SD, CF or USB device into a card reader that is connected via USB to your PC. 
2. If you are connecting a PSP, make sure it is connected via USB cable, and that the console is in “USB 

Connection” mode. 
3. Double-click the PS3 GameShark Movie Player and Media Manager icon on your PC desktop to start. 

 
d) Registration process 

1. When launching the application for the first time you’ll be guided through the registration process.  
2. In order to register please ensure you have an active internet connection. Insert your email address, 

chosen password and MCODE (this can be found on the Mcard included with this product) into the 
User Configuration section, and click “OK” to register the PS3 GameShark Movie Player and Media 
Manager.  

3. Once the product has been registered correctly a confirmation message will appear. You can now use 
all the functions within the application. 
 

 
2) AN OVERVIEW OF THE PS3 GAMESHARK MOVIE PLAYER AND MEDIA MANAGER 
INTERFACE  
PS3 GameShark Movie Player and Media Manager creates a single point interface for all your PS3 or PSP 
related media. New media files can be added quickly and easily and your movies, music, photos and game 
saves are all accessible via a single application. When you first start your PS3 GameShark Movie Player and 
Media Manager software, you will be presented with an interface consisting of two different panels as shown 
below. Details of each panel and its functions are explained in more detail below: 
 



a) PC Panel 
This is the left panel that displays all the Gamesave, Photo, Music and Video files stored on your PC. The files 
are stored in folders so you can identify and manage your own files by simply grouping them together.  
 
b) Memory Stick Panel 
This is the Panel on the right and displays the files that are stored on your MS, SD, CF that is in the PSP 
console. 
 
c) User Interface 
 

 
1. FILE- This is the File menu option. It consists of the following sub options: 

- Create folder- Creates a new folder. 
 - Add PC File- Adds a file to the selected folder. 
 - Delete- Deletes the selected. 
 - Refresh- Refreshes the selected window. 
 - Minimize- Minimizes the application. 
 - Close- Closes the application. 

 



2. EDIT- This is the Edit menu option. It consists of the following sub options: 
a. PC FILES- Allows you to edit the name/ information a file. 
b. RSS URL- Allows you to edit the URL for the RSS url. 

 
3. ADVANCED- This is the Advanced Menu option. It consists of the following sub options: 

a. User Configuration- Allows you to enter details to logon to the online database. 
b. Format- Allows you to format the connected Memory Stick, SD Card or USB device 
c. Backup- Allows you to backup the contents of your connected device to PC 
d. Add Album Artwork- Allows you to add Album artwork images to MP3 files. 
e. Conversion Settings- Allows you to change the movie conversion settings. 
f. Convert movie- Converts the selected movie into compatible MP4 

 
4. HELP- This is the Help Menu option. It consists of the following sub options: 

a. About- Displays contact details and information on the product. 
b. Help- Displays a help diagram 

 
5. WEB BANNER- This is the Web Banner. It displays images, animations or messages from the 

GameShark website. It may also be used to display offers that are available from GameShark.net. 
6. IMPORT CD- This button starts the conversion of an audio CD into MP3 format and saves them onto 

your hard drive. 
7. MINIMISE- This button will minimise the application to the taskbar. 
8. CLOSE- This button will close the application. 
9. FILES/ FOLDERS ON MEMORY STICK- These are the files/folders stored on the PSP Memory stick.  
10. CAPACITY BAR- This is the capacity bar and shows the amount of space available on the Memory 

Stick, displayed in KB and MB. 
11. COPY TO PC BUTTON- The Copy to PC button copies the selected file over to a pre-selected folder 

in the PC Window. 
12. WEBSITE LINK- This button links to the Official GameShark website. 
13. COPY TO MEMORY CARD- This is the Copy to Memory Card button and copies selected files or 

folders from the PC to the Memory Stick. 
14. PC FILES – These are the related media files that are stored on the PC. 

 
3) MANAGING FILES  
PS3 GameShark Movie Player and Media Manager allows you to manage convert and download media files 
and game saves. The application allows you to manage one media category at a time. The different categories 
are: VIDEOS, MUSIC, PHOTOS, and GAMESAVES. 
 
To select the type of file you want to manage, click on one of the folders in the PC Panel that correspond to the 
type of file you want to manage. If you want to manage Music files, click on the “My Music” folder in the PC 
Panel; the Memory Stick panel will now display the Music files that are stored on your Memory Stick. If you 
want to convert and transfer video files to your PS3 Memory card, click the “My PS3 Videos” folder, and so on. 
 
Once you have chosen the type of file you want to manage, you can use the various functions. Below the 4 file 
types of Video, Music, Photos and Gamesaves are explained. 
 
4) MY VIDEOS 
PS3 GameShark Movie Player and Media Manager can convert your HD video files (.MKV, .TS etc) to AVC 
format for playback on your PS3 console. The converted files can then be played back on your PS3 console 
via Memory Stick, SD Card or Compact Flash. PS3 GameShark Movie Player and Media Manager can also 
convert and rename videos to AVC that can be played back on your PSP console.  
 
PLEASE NOTE: All HD movie files conversion outputs by PS3 GameShark Movie Player are progressive. They 
are either 480p, 720p or 1080p. So if the original movie file you convert is interlaced (1080i, 480i etc), to ensure 
the best quality playback, try setting the PS3 to output in an interlaced mode.  
 
To do this go to “Display Settings” on the PS3 browser menu, and select 1080i as the output. This is if the 
original movie you converted was interlaced. 



 
 
 
 
a) Video Conversion 
PS3 GameShark Movie Player and Media Manager can convert the following types of video file for playback on 
PSP: 
 

• MKV 
• AVI, XVID, DIVX 
• VOB 
• MPEG 1, M1P 
• MPEG 2, TS, M2P 
• WMV,ASF 
• MP4 
• OGM 

 
The video files are converted automatically when copied across to the connected MS, SD, CF or USB device. 
Copying and converting files is easy, and is explained below. 
 
PS3 GameShark Movie Player and Media Manager movie conversion relies on you having the video codec’s 
installed for the file types you want to convert. It can convert any video file you can play in Windows Media 
Player. So if you want to convert a XVID file to AVC for PS3 playback, you must have an XVID codec installed 
on your PC. 
 
For more information check out our website www.gameshark.com and go to the support section, and for 
codec information go to www.free-codecs.com or www.dvd.box.sk  
 
A good decoder for installation is called FFDShow, you can download this from here:  
 
http://www.free-codecs.com/download/FFDShow.htm 
 
If you wish to convert a DVD for PSP playback, you must first extract the VOB file from the DVD, and also have 
VOB filters installed on your PC, so that you can watch the VOB in Windows Media Player, or Nero Showtime. 
Circumnavigating the copy protection of a DVD or protected digital data is illegal within the EU without the 
consent of the copyright owner and therefore, PS3 GameShark Movie Player and Media Manager does not 
incorporate this functionality. Outside of the EU and where allowed, software is available via the internet that 
allows you to do this. Please check www.gameshark.com for further details. 
 
b) Adding Video files to the “My PS3 Videos” or “My PSP Videos” folder 
Firstly the video files on your PC need to be added to the “My PS3 Videos” or “My PSP Videos” folder before 
they can be copied to the Memory Stick.  
 
If you want to convert and copy the video to be played on the PS3, add it to the “My PS3 Videos” folder. If you 
want to convert and copy the video to be played on the PSP, add it to the “My PSP Videos” folder. 
 
You can do this in two ways: 
 

1. To add a video file to one of the Video folders, select the video folder with a mouse click, so it is 
highlighted (to confirm the destination folder).  

2. Now select the “File” menu option 
3. Select “Add PC File” 
4. Browse your PC directories until you find the video file you want to add to the folder 
5. Click OK and the video file will be added to the “My Videos” folder in PS3 GameShark Movie Player 

and Media Centre. 
6. Repeat these steps to add as many files as you wish to the selected video folder 

 

http://www.gameshark./
http://www.free-codecs.com/
http://www.dvd.box.sk/
http://www.free-codecs.com/download/FFDShow.htm


If you are familiar with PC techniques, you can “Drag and Drop” video files into the video folder. To do this: 
 

1. Select the “My PS3 Videos” or “My PSP Videos” folder with a mouse click so it is highlighted (to 
confirm the destination folder).  

2. Now open the Windows folder that the video file is in (ensuring you can still see the PS3 GameShark 
Movie Player and Media Manager interface and the video file folder). 

3. Now drag and drop the video file over the video folder in the PS3 GameShark Movie Player and Media 
Manager interface. 

4. The file will now be added to the video folder. 
5. Repeat these steps to add as many files as you wish to the video folders. 
 

PLEASE NOTE 
When adding large files (100MB or over) to the My PS3 or My PSP Videos folder, rather than dragging the files 
into the PSP GameShark interface (which may cause the software to slow down), copy them to the following 
directory on your PC: C://Program Files/Fire International/PS3 Gameshark/Saves/My PS3 Videos then re-start 
the software.  
 
If you have a DVD without copy protection, you can copy the VOB file direct from the DVD disc to the folder 
above. 
 

1. Access your DVD drive via the My Computer icon on your desktop. 
2. Explore the drive to view the contents of the DVD disc. 
3. Open the VIDEO_TS folder, and copy the VOB file to the C://Program Files/Fire International/PS3 

Gameshark/Saves/My PS3 Videos directory. 
4. Refresh the PC files interface using the File menu option and the VOB will appear in the list. 
5. Copy and convert the VOB file as explained below. 

 
c) Converting video files - Video Conversion Settings 
GameShark Movie Player and Media Centre gives you the option of 7 preset movie conversion settings; 3 
settings for PS3 conversion and 2 settings for PSP conversion. All movies are converted with AVC codec. The 
presets are as follows: 
 

Setting Format Video 
Codec 

Audio  
Codec 

Audio Frames 
per 
second 

Audio 
Freq. 

Size Aspect 
Ratio    

Video  
kbps 

Audio 
Kbps 
Per 
channel 

PS3 
High 

1080p AVC AAC Stereo 29.97 48 1920 
x 

1080 

16:9 10000 80 

PS3 
Medium 

720p AVC AAC Stereo 29.97 48 1280 
x 

720 

16:9 4500 64 

PS3 
Low 

480p AVC AAC Stereo 29.97 48 720 
x 

480 

3:2 2000 48 

PSP 
High 

N/A AVC AAC Stereo 29.97 48 320 
x 

240 

4:3 768 56 

PSP 
Medium 

N/A AVC AAC Stereo 29.97 48 320 
X 

240 

4:3 512 56 

PSP 
Low 

N/A AVC AAC Stereo 29.97 48 320 
x 

240 

4:3 384 48 

 



When converting a movie, try to match the size of the converted movie with that of the original file, or one that 
is smaller in size. This will avoid the converted video file being bigger than necessary and taking up 
unnecessary space on the MS/SD card.  
 
For example, if you have a video file that is a recording of a TV show that is 640 x 576 in size, you should 
choose the PS3 Low 480p conversion setting. If you choose to convert to a PS3 High setting the converted 
video will look the same as if you chose the PS3 Low setting, but the file size will be much bigger. 
 
If you have a HD 1080i or 1080p video file, you should choose the PS3 High 1080p setting, or the PS3 Medium 
720p setting.  
 
 

1. To change the video settings go to the Advanced Menu Option 
2. Select the Conversion Settings option 
3. Select the conversion setting you want to convert to.  
4. Your preference will be saved and all video will be converted at the selected rate unless the option is 

changed. 
 
d) Converting video files – Converting and copying for PS3 
When video files are copied to a PS3 Memory device such as MS, SD card or CF card they are automatically 
converted into AVC format for playback on PS3. This is suitable for smaller files (50MB or less) but for larger 
video files it is better to convert the film first, then copy to your Memory Card/USB Device. 
 

1. Ensure you have selected the correct conversion setting as explained in section 4 c) above. 
2. Double click the “My PS3 Videos” folder so it opens and displays the videos you have added. 
3. Right Click the video that you want to convert, and select the “Convert Movie” option. 
4. Enter the file name you want to call the converted movie. Note, if the original file is an MP4 file, you will 

have to select a different file name. 
5. The Movie will now be converted. On the progress bar you will notice an ETA counting down. This 

displays the expected remaining conversion time: 
 

 
 

6. Once the movie has converted successfully, it will be stored in the My PS3 Videos folder. 
7. The movie can now be copied to the connected Memory Card/USB device, either by dragging and 

dropping the movie into the right panel, or by selecting the file and clicking the “Copy to Memory 
Card” button. 

 
Please note 
If you encode a movie with the highest PS3 conversion setting, 1080p, it may take some time. After the movie 
has finished converting, you may not be able to play the file properly on your PC. However, on the PS3 the 
video will play fine. This is because your PC may not be powerful enough to play the converted movie, however 
the PS3 will be. 
 
If you try and play a 1080p movie direct from a Memory Card via card reader, from a USB device such as a 
hard drive, or directly in the PS3 60GB version then the movie streaming may not be fast enough from the 
device. If this is the case you can copy the movie to the PS3 hard drive and play it from there. 
 
 
e) Converting video files –Converting and copying for PSP 



When video files are copied over to the PSP they are automatically converted into the PSP compatible format, 
and renamed so the PSP will play them. There are two ways to copy files to your PSP Memory Stick: 
 

1. Ensure your PSP is in USB mode and connected to the PC. 
2. Double click on the “My PSP Videos” folder to open it. The video files available for copying and 

converting will be shown. 
3. Select the video file you want to copy to your PSP Memory Stick so it is highlighted (ensure you have 

enough free space on your Memory Stick by checking the Capacity Bar). 
4. Click the “Copy to Memory Card” button on the PS3 GameShark Movie Player and Media Manager 

interface. 
5. The conversion and copy process will now take place; a bar will display progress of the conversion. 

Depending on the file size, the conversion may take some time. 
6. You will now see the file appear in the Memory Stick panel with the new name “MAQ0001.MP4” or 

similar. This is the filename format the PSP requires and is created automatically. A copy of the 
converted file is also placed in the “My PSP Videos” folder on your PC. As memory stick space is 
generally limited, you may delete the video file from your PSP. If you wish to transfer the video file 
again at a later date, you can simply copy the pre-converted file across without the need for converting 
the original file again. You do not need to convert the file again. 

7. To watch your newly converted video, close the PS3 GameShark Movie Player and Media Manager 
interface and remove the PSP safely from your PC using the “Unplug or Eject Hardware” option of 
Windows. You can then select the Movie function on your PSP and select the video you have just 
converted or transferred. 

 
If you are familiar with PC techniques, you can “Drag and drop” video files from the PC panel to the Memory 
Stick panel to convert and copy them across. 
 
Note: You can also convert video files without transferring to your PSP. This function is useful as the Memory 
Stick has limited space, and you may want to convert a number of large files at one time. Once converted, you 
can copy the required files across to your PSP when needed. To convert video files without copying to your 
PSP, simply right click the video file and select “Convert Movie”. 
 
PLEASE NOTE 
If you have transferred files to the Memory Card or USB device, you MUST close the application and use the 
Unplug or Eject Hardware option of Windows (usually found on the Taskbar). If you do not do this then your file 
may not be saved to your Memory Stick. This is due to Windows and not the PS3 GameShark Movie Player 
and Media Manager application. 
 
f) Deleting Video Files 
To delete Video files from the PS3 GameShark Movie Player and Media Manager: 
 

1. To delete a file either from the PC panel, or from the Memory Stick panel, click on the file so it is 
highlighted. 

2. Press the delete button on your keyboard, or select the File menu option, then select Delete. 
3. Confirm the deletion of the file and the file is deleted or select cancel if you change your mind. 

 
PLEASE NOTE 
If you delete a file from the Memory Stick Panel, the file cannot be recovered. You may want to make a copy of 
the file to a PC folder before deleting the file from the Memory Stick. 
 
If you delete a file from the PC panel, the file will be removed from the PS3 GameShark Movie Player and 
Media Manager interface, but the source file originally copied from your Windows desktop will still be intact. 
 
5) MUSIC 
PS3 GameShark Movie Player and Media Manager allows you to manage your music files and copy them to 
your Memory Stick or other storage device, you can even copy direct from iTunes™ to the PS3 GameShark 
Movie Player and Media Manager! 
 



GameShark Movie Player and Media Centre is compatible with MP3, AAC (.MP4) and WAV music/audio files. 
Please note, any other music file types copied to your PSP will not be recognised. Files with embedded Album 
art will also be transferred across to the PS3 Memory Stick/ PSP.(Note: AACs in iTunes may have artwork 
attached, but this is not embedded in the audio file and as such, may not be displayed when transferred). 
 
To start managing your music files, click the “My Music” folder on the PC panel. This will show the music 
contents of your connected Memory device (if any). 
 
To copy your songs over to your Memory Stick or USB device you must first put them in the “My Music” folder 
on the PC Panel of the interface. 
 
a) Adding Music files to the “My Music” folder 
Firstly the Music files on your PC need to be added to the “My Music” folder before they can be copied to the 
Memory Stick. You can do this in two ways: 
 

1. To add a music file to the “My Music” folder, select the “My Music” folder with a mouse click so it is 
highlighted (to confirm the destination folder).  

2. Now select the “File” menu option. 
3. Select “Add PC File”. 
4. Browse your PC directories until you find the file you want to add to the folder. You can select multiple 

files by holding CTRL or SHIFT whilst clicking on them. 
5. Click OK and the music will be added to the “My Music” folder in PS3 GameShark Movie Player and 

Media Centre. 
6. Repeat these steps to add as many files as you wish to the My Music folder 

 
If you are familiar with PC techniques, you can “Drag and Drop” music files into the “My Music” folder. To do 
this: 
 

1. To drag and drop a music file into the My Music folder, first select the “My Music” folder with a mouse 
click so it is highlighted (to confirm the destination folder).  

2. Now open the Windows folder that the music file is in (ensuring you can see the PS3 GameShark 
Movie Player and Media Manager interface and the music file folder). 

3. Now drag and drop the music or audio file into the “My Music” folder in the PS3 GameShark Movie 
Player and Media Manager interface. You can select multiple files by holding CTRL or SHIFT whilst 
clicking on them, and then hold the left mouse button down on one file and drag all the selected files 
across into the “My Music” Folder. 

4. The file will now be added to the “My Music” folder. 
5. Repeat these steps to add as many files as you wish to the My Music folder 

 
b) Organising your music files 
You can organise your music files within the PS3 GameShark Movie Player and Media Manager interface, and 
catalogue your songs by artist, genre or any other method you prefer. 
 
You do not have to store your music files in the default “My Music” folder, you can create your own specific 
folders and store your chosen Music files in them. 
 
To create a new folder in which to store music files follow these steps: 
 

1. Select the “File” menu option 
2. Select “Create Folder” and the dialog box below will appear: 

 



3.  
 

4. Select “Music” from the drop down menu as the file type and “PC Saves” as the location. 
5. Type in the name you want to call the folder (e.g. “Rock” if you want to store Rock music files in it). 
6. Click OK and the folder will appear in the PC panel. 
7. You can now add files to this folder as described in the “Adding Music files to the “My Music” folder”, 

replacing “My Music” with the folder you have just created. 
 
c) Copying Music files to your Memory Card/USB Device 
.You can copy music folders you have created (see above) and all their contents across, or you can copy 
single files across to the PSP Music folder. 
 

1. Ensure your PSP is in USB mode and connected to the PC, or your Memory Stick, SD card, USB 
device. 

2. Select the music file or folder you want to copy to your PSP Memory Stick so it is highlighted (ensure 
you have enough free space on your Memory Stick by checking the Capacity Bar). You can select 
multiple files by using the CTRL or SHIFT buttons on your keyboard. 

3. Click the “Copy to Memory Stick” button on the PS3 GameShark Movie Player and Media Manager 
interface. 

4. The copy process will be displayed on screen 
5. You will now see the file or folder appear in the Memory Stick panel. 
6. To listen to your music on your PSP, close the PS3 GameShark Movie Player and Media Manager 

interface and remove the PSP safely from your PC using the “Unplug or Eject Hardware” option of 
Windows. 

7. Select the Music icon on the PSP to play your music. (see your PSP manual for details) 
 
If you are familiar with PC techniques, you can “Drag and drop” music files or folders from the PC panel to the 
Memory Stick panel to copy them across. 
 
PLEASE NOTE 
If you have transferred files to the Memory Stick, you MUST close the application and use the Unplug or Eject 
Hardware option of Windows (usually found on the Taskbar). If you do not do this then your file may not be 
saved to your Memory Stick. This is due to Windows and not the PS3 GameShark Movie Player and Media 
Manager application. 
 
d) Copying songs from iTunes to PS3 GameShark Movie Player and Media Manager  
If you use iTunes to organise your music, then you can copy your songs from iTunes to the PSP GameShark 
Movie Player interface then copy the files to PSP. GameShark Movie Player and Media Centre can accept both 
MP3 or AAC encoded music files from iTunes. 
 
To copy songs from iTunes to PSP GameShark Movie Player and Media Centre, follow the steps below: 
 

1. Open iTunes and select the playlist/library you want to copy from. 
2. Open PS3 GameShark Movie Player and Media Manager and select the “My Music” folder, or other 

music folder you want to copy the song to. 



3. Simply click and drag the song from iTunes and drop into the highlighted folder in PSP GameShark 
Movie Player and Media Centre. You can select multiple files by using the CTRL and SHIFT buttons on 
your keyboard. 

4. The file will now be added to the folder. Repeat this with as many tracks as you wish. 
5. You can now copy these files to your connected Memory Card or USB device as detailed earlier. 

 
If the songs are MP3 format they will be copied as per the original formatting. If the songs are AAC encoded 
from iTunes (file extension .M4A) then upon copying to your PS3 Memory Card, USB Device or PSP console, 
PS3 GameShark Movie Player and Media Manager will change the extension to.MP4 format so the PS3 and 
PSP can play this file type. 
 
PLEASE NOTE 
Songs/Files that have been purchased and downloaded from the iTunes Music store cannot be copied from 
iTunes into the GameShark Movie Player and Media Centre interface. 
 
e) Renaming your music files 
You can rename your music files in the application. This feature allows you to change the order of  your music 
tracks when copied across to the PSP for playback. 
 
If you want a particular track to play first, put “01” at the start of the file name. The second track you want to be 
played “02” and so on. 
 
To rename your files or folders: 
 

1. Select the file or folder you want to rename. 
2. Right Click on the file with your mouse and select the “Rename” option. 
3. Type in the name you wish to call the file or folder. 
4. Click OK 
5. The file/folder will refresh and the new name will be saved. 

 
f) Deleting music files or folders 
       1. To delete a file either from the PC Panel or from the Memory Card panel simply click on the file so it is 
highlighted. 
       2. Press the delete button on your keyboard, or select the File menu option, then select Delete. 
       3. Confirm the deletion of the file and the file is deleted. 
 
PLEASE NOTE 
If you delete a file from the Memory Card Panel, the file cannot be recovered. You may want to make a copy of 
the file to a PC folder before deleting the file from the Memory Card. 
 
If you delete a file from the PC panel, the file will be removed from the PS3 GameShark Movie Player and 
Media Manager interface, but the source file originally copied from your Windows desktop or iTunes will still be 
intact. 
 
g) Importing your own CD collection to your PC 
PS3 GameShark Movie Player and Media Centre can also import your existing CD collection into the PC for 
use on your PSP. The files are compressed into MP3 format and there's also a handy internet database query 
feature which automatically creates the album, artist and track names of your CD's. 
 
To Import your own CD: 
 

1. Insert a CD into the PC CD Tray. (If your PC window pops up to use the CD with any other device, 
select "close" or "cancel") 

2. Click on the IMPORT CD button (6). 
3. PSP GameShark will now attempt to get the track and album name via the Internet. If no internet 

connection is available or if the album information is not available online, then a message box will pop 
up asking you to enter the name of the album. 



4. The CD will now be imported into the PC Files panel (left panel of interface) Folder, listed under the 
Album Name. 

5. You can now drag and drop this album or selected tracks onto your PSP as described in Section 5c. 
  
PLEASE NOTE: IT IS AN OFFENCE TO COPY COPYRIGHT MATERIAL. PLEASE ENSURE YOU SEEK THE 
PERMISSION OF THE COPYRIGHT OWNER BEFORE UTILISING THIS FEATURE FOR ANY COPYRIGHT 
MATERIAL. 
 
h) Adding an image to an MP3 
You can add images to your MP3s which will be displayed on your PSP while playing the tracks. Images can 
only be added to MP3 music files, not AAC or WAV files  
 

1. Highlight an MP3 on the PC panel, right click to bring up the options and select ADD ALBUM 
ARTWORK (this can also be selected from the Advanced menu). 

2. A browser window will open. Browse and select the image you would like to add to the MP3 and click 
OPEN. 

3. Now transfer the MP3 to your PSP and the image should appear next to the MP3 while playing. 
 

The internet is a good source of album art imagery (e.g. Google Images). 
 
 
6) PHOTOS 
The PS3 and PSP consoles can be used to display your JPG, BMP, GIF or PNG photos or images. 
 
a) Adding Photos or images to the “My Photos” folder 
Firstly the photo or image files on your PC need to be added to the “My Photos” folder before they can be 
copied to the Memory Stick. You can do this in two ways: 
 

1. To add an image file to the “My Photos” folder, select the “My Photos” folder with a mouse click so it 
is highlighted (to confirm the destination folder).  

2. Now select the “File” menu option. 
3. Select “Add PC File”. 
4. Browse your PC directories until you find the image file you want to add to the folder. 
5. Click OK and the file will be added to the “My Photos” folder in PSP GameShark Movie Player and 

Media Centre. Use the CTRL or SHIFT keys to select multiple files before copying. 
6. Repeat these steps to add more files to the My Photos folder. 

 
If you are familiar with PC techniques, you can “Drag and Drop” image files into the “My Photos” folder. To do 
this: 
 

1. To drag and drop an image file into the My Photos folder, select the “My Photos” folder with a mouse 
click so it is highlighted (to confirm the destination folder).  

2. Now open the Windows folder on your PC where the image is stored (ensuring you can see the PS3 
GameShark Movie Player and Media Manager interface and the image file folder). 

3. Now drag and drop the image file over the “My Photos” folder in the PS3 GameShark Movie Player 
and Media Manager interface. You can select multiple files using the CTRL and SHIFT keys. 

4. The file will now be added to the “My Photos” folder. 
5. Repeat these steps to add more files to the “My Photos” folder. 

 
b) Organising your Image files 
You can organise your JPG, BMP, GIF and PNG files within the PS3 GameShark Movie Player and Media 
Manager interface, and catalogue your images. 
 
You do not have to store your JPG, BMP, GIF and PNG files in the default “My Photos” folder, you can create 
your own specific folders and store certain JPG files in them. 
 
To create a new folder in which to store your images follow these steps: 
 



1. Select the “File” menu option. 
2. Select “Create Folder” and the dialog below will appear: 

 

3.  
 

4. Select Photo from the drop down menu as the file type and PC Saves as the location. 
5. Type in the name you want to call the folder. 
6. Click OK and the folder will appear in the PC panel. 
7. You can now add files to this folder in the manner described in the “Adding Photo files to the “My 

Photos” folder”, replacing “My Photo” with the folder you have just created. 
 
c) Copying Image files to your Memory Stick 
You can copy JPG, BMP, GIF and PNG image files across to your PSP Memory Stick very easily.  
 

1. Ensure your PSP is in USB mode and connected to the PC, or your Memory Stick, SD Card, USB 
device is connected correctly. 

2. Select the file you want to copy to your Memory Card so it is highlighted (ensure you have enough free 
space on your memory Stick by checking the Capacity bar). 

3. Click the “Copy to Memory Stick” button on the PS3 GameShark Movie Player and Media Manager 
interface. You can use the SHIFT and CTRL keys to select multiple files. 

4. The copy process will now take place, so a progress bar will appear. 
5. You will now see the file or folder appear in the Memory Card panel. 
6. To view your images on your PSP, close the PS3 GameShark Movie Player and Media Manager 

interface and remove the PSP safely from your PC using the “Unplug or Eject Hardware” option of 
Windows. 

7. Select the Photo/Images icon on your PSP to view the images. (see your PSP manual for details) 
8. If viewing 

 
If you are familiar with PC techniques, you can “Drag and Drop” JPG, BMP, GIF and PNG files from the PC 
panel to the Memory Stick panel to copy them across. 
 
PLEASE NOTE 
If you have transferred files to the Memory Stick, you MUST close the application and use the Unplug or Eject 
Hardware option of Windows (usually found on the Taskbar). If you do not do this then your file may not be 
saved to your Memory Stick. This is due to Windows and not the PS3 GameShark Movie Player and Media 
Manager application. 
 
d) Renaming your JPG, BMP, GIF and PNG files 
To rename your files or folders: 
 

1. Select the file or folder you want to rename. 
2. Right Click on the file with your mouse and select the “Rename” option. 
3. Type in the required name for the file or folder. 
4. Click OK. 
5. The file/folder will refresh and the new filename will be saved. 

 



e) Deleting Image Files or folders 
Deleting JPG files from the PS3 GameShark Movie Player and Media Manager interface is very easy. 
 

1. To delete a file from the PC panel or from the Memory Stick panel , click on the file so it is highlighted. 
2. Press the delete button on your keyboard, or select the File menu option, then select Delete. 
3. Confirm the deletion of the file and the file is deleted, or select Cancel if you change your mind. 

 
PLEASE NOTE 
If you delete a file from the Memory Stick Panel, the file cannot be recovered. You may want to make a copy of 
the file to a PC folder before deleting the file from the Memory Stick. 
 
If you delete a file from the PC panel, the file will be removed from the PS3 GameShark Movie Player and 
Media Manager interface, but the source file originally copied from your Windows desktop will still be intact. 
 
The images on your PSP can be used as background wallpaper for your PSP desktop. Please check your PSP 
manual for details on how to do this. A selection of free wallpapers is available from www.GameShark.net. 
 
7) GAMESAVES 
PS3 GameShark Movie Player and Media Manager includes Cheat saves for the latest and greatest games 
that let you get ahead in your game. GameShark Cheat saves give you access to new levels, characters, items 
and more! 
 
a) Copying Gamesaves to your Memory Card 
To use the Cheat saves on your PS3 or PSP games you first need to copy the save to your Memory Card.  
 

1. Double click on either the “My PS3 Gamesaves” folder or the “My PSP Gamesaves” folder to open it. 
2. Select which gamesave you want to copy to your Memory Stick. 
3. Click the “Copy to Memory Stick” button 
4. The save will be copied to your PSP Memory Stick. 
5. The next time you play the game your save is for, the save will be loaded. 
 

Warning: If you are advised that the save already exists, over-writing will lose an existing save game you have 
on your Memory Card for that game! Select Cancel to keep your original save and back up the original save, 
as detailed below, before transferring the new save across to your Memory Card. 
 
b) Backing up Gamesaves to PC 
You can back-up the existing game saves on your Memory Stick to a PC folder to save space on and ensure 
you have a copy of important saves. To manage your PS3 saves, click the “My PS3 Gamesaves” folder and to 
manage your PSP saves, click the “My PSP Gamesaves” folder. 
 

1. Click the “My PS3 Gamesaves” or “My PSP Gamesaves” folder to open it, depending on which format 
your game saves are for. 

2. Now select the game save on your Memory Card that you want to back up. 
3. Simply drag the game save to the folder on the PC. SO if you select a PS3 game save, drag it to the 

“My PS3 Gamesaves” folder.  
 
8) INTERNET DOWNLOADS 
You can download new gamesaves for the latest games and media content from the GameShark server. To do 
this your PC needs to be connected to the Internet. 
 
a) User Configuration box 
When you first click the Internet Downloads button the user configuration box will appear, this is where you 
enter your details and register your product which is required to authenticate the software you are using: 
 



 
 
Enter your E-mail address, chosen password, a nickname and Product Key (MCODE) into the boxes provided.  
The product key is a 16-digit number that can be found on the Product Key card inside the box of PSP 
GameShark Movie Player and Media Centre. 
 
Once completed, click OK and the Internet Downloads panel will appear: 
 
 
 
 

1. CLOSE- This button closes the Internet Downloads panel. 
2. INTERNET DOWNLOADS- This is the button pressed to open the panel, and can also be used to 

close the panel. 
3. SEARCH- This button brings up the search dialog box that is explained in further detail in this manual. 
4. INTERNET DOWNLOADS PANEL- This is the panel where all the files available for download from the 

GameShark server are displayed. 
5. DOWNLOAD TO PC – This button downloads the selected file to a pre-selected folder in the PC panel. 
6. FILES – These are the files available for download. 



 
b) Searching for files 

1. With the Internet Downloads panel open, click the “Search” button. 
2. A dialog box will appear: 

3.  
 
4. Use the drop down menu to select what type of file you want to search for.  

 
5. When searching for game saves, ensure you select either PS3 or PSP to search the platform you want 

saves for. 
6. Click OK and the search will begin. If you leave the “Name” box blank, all the results for that media 

type will be presented. (e.g. all available game saves). 
7. The search results will be displayed. 

 



 
 
c) Downloading files from Internet Panel to PC folders 
To download the files you have searched for to your PC folders, follow the steps below: 
 

1. In the PC Panel, select the folder you want to download the file to (e.g.; if PS3 saves you are 
downloading, select “My PS3 Gamesaves”). 

2. Now select the file you wish to download. You can select multiple files using the CTRL and SHIFT 
keys. 

3. Click the “Download to PC” button and the file will be downloaded to the chosen folder. 
4. Repeat this process to download as many files as you wish. 

 
1. If you are familiar with PC techniques, you can “Drag and Drop” files from the Internet panel to the PC 

panel to copy them across. 
 
9) RSS FEED 
The RSS feed is a live web based text feed running along the bottom of the PS3 GameShark Movie Player and 
Media Manager user interface. The RSS feed keeps you updated with the latest information on what saves are 
available and PSP related news. An internet connection is required for this feature to function. 
 
You can change the RSS feed to one of your choice (for example MSN).  

1. Go to the “Edit” menu option, and then select “RSS URL”. 
2. Type or paste in the RSS URL of your choice. 
3. Click OK. 

 
The RSS feed will now be updated, and your chosen RSS feed displayed along the bottom of the interface. 
 
 
10) FREQUENTLY ASKED QUESTIONS 
Q: When I try to convert my movies, I get the error “Video connector was not obtained. Failed to convert movie” 
What does this mean? 
A: This means you do not have the correct codec installed to decode the movie. A good rule of thumb is that 
PS3 GameShark can convert any video that can be played in Windows Media Player on your PC. A good 
decoder to install is FFDShow. This can be downloaded here: http://www.free-
codecs.com/download/FFDShow.htm 
 
If you want to decode Matroska .MKV files, you will need to install a Matroska filter, and so on. Check out the 
PS3 GameShark Hints and Tips page at www.GameShark.net for further information on codecs and converting 
movie files. 
 
Q: I can’t seem to get PSP GameShark to connect to the PSP, why is this? 
A: Check you have connected your USB link cable up properly between your PC and the PSP. Turn on your 
PSP and set it to USB Connection from the main menu. Check your PSP Manual on how to do this.. Run the 
PSP GameShark and it should now work. 
A: You must ensure you have a Memory Stick in your PSP, and that your Memory Stick is formatted for use with 
the PSP. This can be done via the “System Settings” option on your PSP. Check your PSP manual for more 
information on how to format your memory stick.  
 
Q: I’ve copied a media file from the PC to the Memory Stick/ USB device, but when I browse the Memory Stick 
using my PSP browser the file is not there. 
A: You might have disconnected the USB cable while the file was being copied. Always disconnect the PSP 
using the Windows Safely Remove Hardware icon in the bottom right of your Windows desktop.  
 
Q: I have copied a file across from my PC to my Memory Stick, but it does not appear to be there. Why is this? 
A: Select ‘Refresh Memory Stick’ from the File menu. This will refresh the Memory Stick Panel, and if 
transferred correctly and it is a recognized file type, your file should now be visible. 
 

http://www.free-codecs.com/download/FFDShow.htm
http://www.free-codecs.com/download/FFDShow.htm
http://www.xploder.net/


Q: I have updated the software to the latest version but still have occasional problems. 
A: We suggest that if you have internet access, you should use Windows Updates to update your version of 
Windows. Microsoft continually develops Windows to improve and fix various issues. We therefore recommend 
you keep your version of Windows as up to date as possible. Our software is always designed to run with the 
latest updated versions of Windows and it is good practice to ensure your PC is updated with the latest 
security updates from Microsoft. 
 
Q: Does it matter which USB port I plug the cable into on the PC? 
A: No. 
 
Q: Can I plug it into a USB2.0/USB Hi-Speed port? 
A: Yes. 
 
Q: Can I plug the cable into a hub/extension cable?  
A: Yes, although if you have any problems, try plugging it directly into a USB port on your PC. 
 
Q: Will I get free upgrades to the software? 
A: Major versions will be released as new products, but minor versions may be released for free as an upgrade 
at GameShark’s discretion. 
 
Q: Can I use saves from other sites with PSP GameShark? 
A: No, you can only use saves for PSP GameShark from GameShark site. 
 
Q: When registering my product with you, will it give out further information about me or my PC? 
A: No, it will only ask for your username, email address and product key by way of authentication. We use this 
information in order to keep our services and products secure and to provide you with support should you 
experience any difficulties along with selected offers and update advice. 
 
Q: I have a suggestion which I think might be useful in this product. 
A: We welcome any feedback. Please email us at the support address below and let us know. 
 

11) CUSTOMER SUPPORT 
PLEASE CHECK WWW.GAMESHARK.COM REGULARLY FOR THE LATEST SOFTWARE UPDATES 
AND INFORMATION. 
 
Contact information: 
 
If you have any problems or queries with this product, feel free to write to: 
 

Phone: (619) 683-2815 
Email: support@gameshark.com 
World Wide Web: http://www.gameshark.com 

Mailing Address: 
Mad Catz, Inc. 
ATTN: GameShark Support 
7480 Mission Valley Road Suite 101 
San Diego, CA 92108 

 
Warranty Information 
To obtain warranty service within the warranty period: 
IN THE USA: Return product to the place of purchase or send the defective item postage prepaid with a 
copy of the sales receipt, return address and a brief description of the problems you are experiencing to the 
above address. 
 
©2004 Mad Catz, Inc. 7480 Mission Valley Rd., Suite 101, San Diego, CA 92108-4406. 

mailto:support@gameshark.com
http://www.gameshark.com/
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